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Access the User Workspace Management Interface
After you have started the Cisco Modeling Labs server, you can access the User Workspace Management
interface to manage user accounts, projects, licenses, and virtual machine images on the CiscoModeling Labs
server.

To access the User Workspace Management interface, complete the following steps:

Step 1 In the Cisco Modeling Labs server, retrieve the IP address of the VM using the command ifconfig eth0.
Step 2 In a web browser, enter the retrieved IP address or hostname in the format, http://<IP address | hostname>.
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The CML Server main menu page is displayed.

Figure 1: CML Server Main Menu

Step 3 Click User Workspace Management to access the User Workspace Management interface.
Step 4 Log in to the User Workspace Management interface using the username uwmadmin and the password password.

When you initially log in to theUserWorkspaceManagement interface, you are advised to change the password
for the uwmadmin account. See the section Change the Password for the uwmadmin Account, on page 3 for
details on how to do this.

Note

The application opens in user mode. To create new users, projects, and so on, you must be in admin mode.
Step 5 To change to admin mode, click Admin under the Switch Mode section. An overview of the current system-usage

statistics for all the active simulations is displayed.

Figure 2: Current Usage Statistics

The task bar on the left enables the following functions:

• Projects—Allows you to import and export projects. You can also add new projects, enable, disable, modify, and
delete current projects.
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• Users—Allows you add new user accounts, enable, disable, modify, and delete current user accounts.

• Images—Allows you add new virtual machine images, modify, and delete current images. You can also modify
and delete image snapshots.

• Flavors—Allows you add and delete virtual machine flavors.

• Subtypes—Allows you to import, export, and duplicate subtypes.

• Connectivity—Allows you to add L2 FLAT IP addresses, L3 SNAT IP addresses, and Project Management IP
Addresses.

• Statistics—Provides system statistics for system status, projects and users, simulations, and AutoNetkit usage.

• VM Control—Allows system administrators to stop specific components of an active simulation.

• Licenses—Manages product licenses on the system.

Change the Password for the uwmadmin Account
The uwmadmin account is used to manage server resources and user access. Therefore, to reduce the risk of
unauthorized access, we recommend that you change the default password for the uwmadmin account to a
more secure password on initial login.

Step 1 Login in to the User Workspace Management interface with username uwmadmin and password password.

Step 2 Click Admin under the Switch Mode section to switch to admin mode.

Step 3 Click Settings and password.
The Settings page is displayed.

Figure 3: Settings Page

Step 4 Click Change Password.
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The Change Password page is displayed.
Step 5 Enter new password details and click Confirm to save the changes.

Admin Mode Versus User Mode
When you log into the User Management Workspace interface as administrator, there are two modes of
operation available to you; these are Admin and User. The following tables describe the different functions
available for each mode.

Table 1: Admin Mode Functions

DescriptionFunction

Allows you to import and export projects. You can also add new projects,
enable, disable, modify, and delete current projects.

Projects

Allows you add new users, enable, disable, modify, and delete current users.Users

Allows you add new images, modify, and delete current images. You can
also modify and delete image snapshots.

Images

Allows you add and delete flavors.Flavors

Allows you to import and export subtypes. You can also create a custom
subtypes, using the specialize option. You create a new subtype based on
one of the available built in subtypes.

Subtypes

Allows you to add and delete L2 Flat IP, L3 Snat IP, and Management IP
allocations for projects.

Connectivity

Provides system statistics for system status, projects and users, simulations
and AutoNetkit usage.

Statistics

Allows you to delete nodes, networks, ports and IP allocations when problems
are encountered.

VM Control

Table 2: User Mode Functions

DescriptionFunction

Allows you add new images, modify, and delete current images. You can
also modify and delete image snapshots.

Images

Lists details for the available flavors.Flavors
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DescriptionFunction

Lists details for the available subtypes.Subtypes

Lists details for the available connections.Connectivity

Allows you to change your password.Settings and Password

Manage Projects
Within the User Workspace Management interface, a project represents a set of resources that are available
to each project. It has the following characteristics:

• By default, a project user account is created for each project.

• To add a user as a standalone user, a project must be assigned to the user. Also, the username will be
the project name.

• Additional users can be assigned to a project as required.

• If a user is added to a project, the username of the user is prefixed with the project name.

• Deleting a user account does not delete a project that the user is assigned to.

• Deleting a project deletes only the associated default user; nondefault user accounts are not deleted.

In the Projects page, you can perform a number of operations for projects. These operations are:
DescriptionOperation

Imports a project and its users from a JavaScript Object Notation (JSON) or
tab-Separated values (TSV) file.

Import

Exports a project and its users as a JSON or TSV file.Export

Creates a new project.Add

Enables a selected project.Enable

Disables a selected project.Disable

Modifies details for a selected project.Modify

Deletes a selected project and its users.Delete

Import a Project
Files for import must be in the JSON or TSV format and must have previously been exported from the User
Workspace Management interface.
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To import a project and its users, complete the following steps:

Step 1 In the User Workspace Management interface, in admin mode, click Projects.
The Projects page, which lists all of the current projects, appears.

Step 2 Click Import to import a new project and its associated users.

The Import Projects and Users page appears.
Step 3 Click Browse to locate the applicable JSON or TSV file for import.

If you import projects and users that already exist, they will be updated. After importing users, the STD server
needs to be restarted.

Note

Step 4 Click Import.
The newly imported project is listed on the Projects page.

Export a Project
To export a project and its users, complete the following steps:

Step 1 In the User Workspace Management interface, in admin mode, click Projects.
The Projects page, which lists all of the current projects, appears.

Step 2 Check the check box beside the project or projects for export.
Step 3 Click Export to export the applicable project and projects and all its users.

Step 4 From the drop-down list, choose the type of file to export to, JSON or TSV.
The Open dialog box appears.

Step 5 Click the Save radio button and click OK to save the file.
The exported file is saved to the specified location.

Create a Project
To create a new project, and a user for the project complete the following steps:

Step 1 In the User Workspace Management interface, in admin mode, click Projects.

The Projects page, which lists all of the current projects, appears.
Step 2 Click Add to create a new project.
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The Create Project page appears.

Figure 4: Create a Project

Step 3 UnderGeneral Settings, add a name and a description for the project. In the Expires field, you can either add an expiry
date for the project or accept the default, which is Never, meaning the project will never expire. Leave the Enabled
check box checked to enable the project for use.

Step 4 Under Project Quotas, you can either accept the default values for the system quotas or increase or decrease them based
on your project requirements:

• Instances quota is the maximum number of virtual machines of any type that can be operational at any given time
within the project per user or for all users associated with that project.

• RAM (MB) is the maximum RAM that can be consumed by virtual machines running in the project per user or
for all users associated with that project.

• VCPUS is the maximum number of virtual cores consumed by the virtual machines running in the project.

Step 5 Click Create.
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The Edit User page appears.

Figure 5: Edit the Project User

Using this window, you can add details for the new user created when the project is created.

Step 6 In the Password and Password Again fields, enter a new password for the user.
The default password can be used or a more meaningful password can be entered. This password can also be
changed at a later time.

Note

Step 7 In the Email field, add a valid email address for the user.
By default, the user is assigned a member role.

Step 8 In the Expires field, you can add an expiry date for the user or accept the default Never. Leave the Enabled check box
checked to enable the project for immediate use. Alternatively, you can set up a project and users, but you cannot enable
them to be configured and available at a later time.

Step 9 Click Save to save the changes for the user.
Step 10 (Optional) To confirm that the project has been added, click Projects to view the newly added project, and click Users

to view the newly added user. Otherwise, logout.

Manage Users
Within the User Workspace Management interface, you can manage user accounts from the Users page.
User accounts permit access to the Cisco Modeling Cisco Modeling Labs server from the Cisco Modeling
Labs client.

In the Users page, you can perform a number of operations for users. These operations are:

In the Users page, you can perform a number of operations for users. These operations are:
DescriptionOperation

Creates a new user account.Add
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DescriptionOperation

Enables a selected user account.Enable

Disables a selected user account.Disable

Modifies details for a selected user account.Modify

Deletes a selected user account.Delete

Create a User
To create a new user, complete the following steps:

Step 1 In the User Workspace Management interface, in admin mode, click Users.
The Users page, which lists all the default users, appears.

Step 2 Click Add to create a new user.
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The Create User page appears.

Figure 6: Create a User

Step 3 In the Username field, enter a username for the new user.
To create multiple users, click the Add (+) icon to the right of the Username
field.

Note

Step 4 In the Password and Password Again fields, enter a password for the new user.
Step 5 In the Email field, enter a valid email address for the user.
Step 6 From the Project drop-down list, choose the applicable project for the user.
Step 7 From the Role drop-down list, choose the applicable role for the user.

A user with administrative rights has administrative rights across the entire system.Note

Step 8 In the Expires field, you can either add an expiry date for the user or accept the default, which is Never.
Step 9 Leave the Enabled check box checked.
Step 10 Click Create.

The User <Project Name>-<Username> page appears.

This page presents details and project quotas for the user.
Step 11 (Optional) ClickModify User to amend the details for a user, or click Delete User to delete a user.
Step 12 Click Users to view the newly created user.
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Expire a User Account
While the option to disable a user account is available in the User Workspace Management interface, it is
advisable that you expire a user account rather than disable it. When a user account with running simulations
is disabled, the project is effectively frozen and simulations can only be stopped by the administrator via VM
Control. However, if a user account with running simulations is expired, the administrator can stop the running
simulations for the expired user account.

To expire a user account, complete the following steps:

Step 1 In the User Workspace Management interface, in admin mode, click Users.
The Users page, which lists all of the default users, appears.

Step 2 Click the user account to be expired.
The User Details page appears.

Step 3 In the Expires field, enter an expiry date and time for the user account, or use the calender icon.
Step 4 Click Save.

The User Details page appears and shows the expiry date for the user account.

Manage VM Images
Within the User Workspace Management interface, you can add new images, update details for existing
images, or delete images from the system. Additionally, you can take a snapshot of the disk content of a virtual
machine image. This newly created user-specific disk image can be used in other simulated sessions.

Cisco Modeling Labs 1.1 includes the following images built into the Cisco Modeling Labs client:

• Cisco Virtual IOS (IOSv) Software Release 15.5(3)M

• Cisco IOSv Layer 2 Switch Software Release 15.2.(4.0.63)E

• Linux server (Ubuntu 14.04.2 LTS Cloud-init)

For the most up-to-date list of virtual images, see Release Notes for Cisco Modeling Labs 1.1.

Additionally, the following demonstration images are included in the build:

• Cisco IOS XRv Software Release 5.3.1 CCO

• Cisco CSR1000v Software Release 3.16 XE-based

The following production images are available to purchase separately:

• Cisco IOS XRv Software Release 5.3.1

• Cisco CSR1000v Software Release 3.1.6

• Cisco ASAv Software Release 9.4.1

In the Images page, you can perform a number of operations for images. These operations are:
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In the Images page, you can perform a number of operations for images. These operations are:
DescriptionOperation

Creates a new virtual machine image.Add

Modifies details for a selected virtual machine image.Modify

Deletes a selected virtual machine image.Delete

Create a Virtual Machine Image
To create a new virtual machine image, complete the following steps:

Step 1 In the User Workspace Management interface, in admin mode, click Images.

The Images page, which lists all of the available registered images, appears.

Images listed in admin mode are available to all
users.

Note

Step 2 Click Add to create a new image.
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The Create Shared VM Image page appears.

Figure 7: Create Shared VM Image

Step 3 From the Subtype drop-down list, choose the appropriate subtype for the new image.
Step 4 In the Name/Version field, enter a name or version number for the image.
Step 5 In the Image Path field, enter a path on the server/virtual machine (an HTTP, FTP or TFTP URL) or choose a file to

upload.
Step 6 To upload an image from your own device, click Browse to navigate to the image file.
Step 7 Leave the Properties field blank because by default, appropriate properties are automatically set based on the chosen

subtype.
Step 8 Click Create to create your virtual machine image.

The creation process can take a while depending on where the image file is located relative to the CiscoModeling
Labs server. Both virtual machine disk (VMDK) and QEMU copy-on-write 2 (QCOW2) image formats are
supported. As part of the creation process for images, a flavor is also created, which contains information on
the CPU and memory allocation for the virtual machine image.

Note

The Image <Image Name> page, which contains the details and properties of the virtual machine image, appears.

Step 9 Click Images to view the newly added image.
Step 10 Under the Options column, use theModify or Delete options to amend the details for the virtual machine or to delete

a virtual machine image. After the image is installed, it is available for users to select for their topology simulation.
Step 11 In the Cisco Modeling Labs client, click File > Preferences > Node Subtypes
Step 12 In the Node Subtypes dialog box, click Fetch from Server.

The Confirm dialog box is displayed.
Step 13 Click OK to update the list of node subtypes based on the currently configured Cisco Modeling Labs server.
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Create an Image Snapshot
When a Linux server is present in a running simulation, you can take a snapshot of the disk content of the
server. This newly created user-specific disk image can be used in other simulated sessions.

To take a snapshot of the server's disk content, complete the following steps.

Step 1 Log in to the User Workspace Management interface.
You must log in as a user other than the uwmadmin user, for example,
guest.

Note

Step 2 On the Overview page, under Sessions, choose the applicable running session.
A list of active virtual machines is displayed.

Step 3 Choose the applicable virtual machine image, and from the Options drop-down list, click Create Snapshot.
Project details for the newly created snapshot are displayed.

Figure 8: Newly Created Image Snapshot

The image snapshot can be reused in the Cisco Modeling Labs client under Properties > Node > VM Image.

See Cisco Modeling Labs Corporate Edition User Guide, Release 1.1 for more information.

Manage Virtual Machine Flavors
Within the User Workspace Management interface, as part of the creation process for virtual machine
images, a virtual machine flavor is created. Flavors are used in each virtual machine to define the CPU, memory
(RAM) allocation, disk space, the number of cores, and so on.

In the Flavors page, you can perform a number of operations for flavors. These operations are:
DescriptionOperation

Creates a new flavor.Add

Deletes a selected flavor.Delete
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Create a Virtual Machine Flavor
To create a new virtual machine flavor, complete the following steps:

Step 1 In the User Workspace Management interface, in admin mode, click Flavors.

The Flavors page, which lists all of the available flavors, appears.
Step 2 Click Add to create a new flavor.

The Create Flavor page appears.

Figure 9: Create a Flavor

Step 3 In the Name field, enter a name for the flavor.
Step 4 From the RAM drop-down list, choose the amount of memory allocation for the flavor.
Step 5 From the Virtual CPUs drop-down list, choose the number of virtual CPUs for the flavor.
Step 6 Click Create to create your virtual machine flavor.

The Flavors page appears with the newly created flavor listed.
Step 7 Under the Options column, use the Delete option to delete a virtual machine flavor.
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Manage Subtypes
In the User Workspace Management interface, the Subtypes page provides a list of integrated subtypes,
which users can use as templates to create their own custom subtypes. Using the Specialize option for a
subtype, a user can duplicate the subtype template make the necessary updates to create a new custom subtype.
Subtypes can be imported and exported, which allows users to apply their custom subtypes to other Cisco
Modeling Labs server installations.

In the Subtypes page, you can perform a number of operations for subtypes. These operations are:
DescriptionOperation

Imports a subtype from a JSON file.Import

Exports a subtype to a JSON or TSV file.Export

Duplicates an available subtype to create a custom subtype.Specialize

Import a Subtype
Subtypes for import must be available in a JSON file.

To import a subtype, complete the following steps:

Step 1 In the User Workspace Management interface, in admin mode, click Subtypes.
The Subtypes page, which lists the integrated subtypes, appears.

Step 2 Click Import to import a new subtype.

The Import Subtypes page appears.
Step 3 In the text area, paste the subtype details from the JSON file.
Step 4 Click Import.

The newly imported subtype is listed on the Subtypes page.
Step 5 (Optional) Click Specialize to create a custom subtype based on the newly imported subtype, clickModify to amend

the details for the subtype, or click Delete to delete the subtype.

Create a Custom Subtype
To create a custom subtype, complete the following steps:

Step 1 In the User Workspace Management interface, in admin mode, click Subtypes.
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The Subtypes page, which lists the integrated subtypes available, appears.
Step 2 For the applicable subtype, click the Options drop-down list next to it and click Specialize.

The Specialize Subtype page appears.
Step 3 Update the subtype fields as required.

You can use the default values on the Subtypes page; however, you must provide a new name for the new
subtype.

Note

Table 3: New Subtype Fields

DescriptionField

Enter a name for the new subtype.Name of new subtype

Provide a description of the plug-in to be created.Description of plugin

Enter a name for the management interface.Name of management interface

Provide the interface name format, for example, GigabitEthernet0/{0}.Pattern for data interface names

Enter a valid integer for the first interface.First data interface number

Enter the maximum allowed number of interfaces.Max count of data interfaces

Enter the permitted number of interfaces per line card (LC) allowed.Number of interfaces per LC

Choose the number of interfaces allowed. Options are 0, 1, 2, 3, and 4.Number of serial interfaces

Choose the type of console connection. Options are Telnet or SSH.Protocol for network CLI

Allow VNC access. Enabled when the check box is checked.Make VNC access

Enter a name for the subtype icon that is displayed in the CiscoModeling Labs
client.

Name of icon for GUI

Allow the subtype icon to be displayed in the Cisco Modeling Labs client.
Enabled when the check box is checked.

Show subtype on GUI palette

Choose the type of configuration disk. Options are cdrom, disk, cloud-init,
iso9660, and vfat.

Configuration disk type

Choose the ISO 9660 level in cdrom disk. Options are 2, 3, and 4.ISO 9660 Level in cdrom Disk

Enter a name for the configuration drive file.Name of file for config drive

Choose a virtual interface model. Options are e1000, vitrio, and rtl8139.Virtual interface model

Choose a main disk bus model. Options are ide, vitrio, and scsi.Main disk bus model

Specify the amount of RAM (MB) to use for each node.RAM (MB) allocated per node
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DescriptionField

Choose the number of CPUs to allocate per node. Options are 1, 2, 3, 4, 5, 6,
and 7.

Number of CPUs allocated per node

Enter any additional image properties.Extra comma-separated image
properties

Enter a name for the default image.(Optional) Name of default image

Enter a name for the default flavor.(Optional) Name of default flavor

You can choose to go with the default values on the Subtypes page; though you must provide a name for the
new subtype.

Note

Step 4 When completed, click Create to create the new custom subtype.
The new subtype is created and its details are displayed in the Subtypes page for the new subtype.

For a newly created subtype, the value in the Dynamic column is Yes, which indicates that the new subtype is
based on a built-in subtype.

Note

Step 5 (Optional) On this page, you can click Specialize to create a custom subtype based on the newly created subtype, click
Modify to amend the details for the subtype, or click Delete to delete the subtype.

Step 6 Click the Subtypes tab to see the custom subtype listed on the page.

System Statistics
You can view various statistics concerning the usage and operation of your Cisco Modeling Labs system.
System statistics are available from the Statistics option on the left-hand side of the interface.

The following areas are covered:
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Table 4: System Statistics

DescriptionArea

Provides a summary of the Cisco Modeling Labs server system state. Includes
information on CPU cores, memory, and disk space (total and free). In addition,
it provides a snapshot of the memory usage history for the last week, the last
month, and the previous 24 hours; the snapshot includes the average and
maximum percentages used.

System Status

Lists the number of currents projects and users.Projects and Users
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DescriptionArea

Lists details for the number of active simulations and nodes for the last week,
the last month, the previous 24 hours, and with those currently running.

There are two further categories:

• Subtype Usage in Simulations—Lists the subtypes and their average and
maximum usage stats.

• Simulation/node Operation Failures—Lists the number of
simulation/node failures for the last week, the last month, and the previous
24 hours.

Simulations
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DescriptionArea

Lists details for the number of configurations generated in the last week, the last
month, and the previous 24 hours, including the number of invalid topologies
encountered. The category Subtype Usage in Configured Topologies lists the
subtypes used in configuration requests along with their average and maximum
usage stats.

AutoNetkit

Connectivity
Within theUserWorkspaceManagement interface, theConnectivity page provides details on all OpenStack
ports available on the external (FLAT and SNAT) and project management networks

• L2 FLAT IP address allocations—Create an externally reachable fixed IP address for a project.

• L3 SNAT IP address allocations—Create a floating IP address for a project. Floating IPs are externally
reachable and are mapped to an internal fixed IP address.

• Project Management IP address allocations—Create a fixed IP address on the management network of
the selected project. This IP address can be statically assigned to the nodes.

DescriptionOperation

Creates a new OpenStack port connection for L2 Flat, L3 SNAT, or Project
Management.

Add

Deletes an OpenStack port connection.
Only detached addresses in the DOWN state can be
deleted.

Note
Delete
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Create an OpenStack Port Connection
To create a new port connection, complete the following steps:

Step 1 In the User Workspace Management interface, in admin mode, click Connectivity.
The Outside Connections page, which lists all current port connections appears.

Step 2 Connections are grouped into three areas: L2 FLAT, L3 SNAT, and Project Management. ClickAdd in the applicable
group to create the required port connection for that type.

The corresponding Add IP Allocation page appears.
Step 3 Complete the fields as required for the applicable port connection.

DescriptionFieldConnection Type

Choose a project from the drop-down
list.

Owning ProjectLayer 2 FLAT IP Address Allocations

Choose a FLAT network from the
drop-down list.

FLAT Network

Enter a name for the new port
connection.

Name

Enter a custom IP address from the
range defined by the prefix displayed,
or to have an address automatically
assigned, leave this field blank.

Fixed IP address
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DescriptionFieldConnection Type

Choose a project from the drop-down
list.

Owning ProjectLayer 3 SNAT IP Address Allocations

Enter a name for the new port
connection.

Name

Enter a custom IP address from the
range defined by the prefix displayed,
or to have an address automatically
assigned, leave this field blank.

Fixed IP Address

Enter a custom IP address from the
range defined by the prefix displayed,
or to have an address automatically
assigned, leave this field blank.

Floating IP Address

Enter a name for the new port
connection.

NameProject Management

Enter a custom IP address from the
range defined by the prefix displayed,
or to have an address automatically
assigned, leave this field blank.

Fixed IP Address

Step 4 Click Create.
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The new connection is created and its details are displayed in the Connectivity page.

Using the VM Control Tool
The VM Control tool is available to aid system administrators with troubleshooting issues encountered in
the User Workspace Management interface. The tool enables system administrators to stop specific
components of an active session. In circumstances where components of a session fail to be deleted through
the normal shutdown methods, this tool enables system administrators to remove blocked components.

Figure 10: VM Control Tool

The applicable components are:

• VM Control Nodes

• VM Control Networks

• VM Control Ports and Floating IPs

• VM Control Hosts
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VM Control Nodes
The VM Control Nodes page lists all the nodes for all the currently running projects for all users. You can
delete a specific node or all the nodes for a specific project or projects.

Figure 11: VM Control Nodes Page

Step 1 To delete a specific node:
a) In the node list for the applicable project, check the corresponding check box.
b) Click Delete in the Options column.

The node is deleted.

Step 2 To delete all the nodes for a specific project:
a) In the node list for the applicable project, check the corresponding Name check box.

When you check theName check box for a particular project, the check boxes for all the nodes in the project
are automatically checked. You cannot uncheck individual nodes within a project; either all the nodes or no
nodes are checked.

Note

b) Click Delete Selected.
All nodes for the particular project are deleted.
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VM Control Networks
The VM Control Networks page lists all the networks for all the currently running projects for all the users.
You can delete a specific network or all the networks for a specific project or projects.

Figure 12: VM Control Networks Page

Step 1 To delete a specific network:
a) In the network list for the applicable project, check the corresponding Name check box.
b) Click Delete in the Options column.

The network is deleted.

Step 2 To delete all the networks for a specific project:
a) In the network list for the applicable project, check the corresponding Name check box.

When you check theName check box, the check boxes for all the networks in the project are automatically
checked. In the VM Control Networks page, for each user project, two networks are listed in blue with
an information icon. These two networks are specifically created for use by OpenStack. We recommend
that you do not delete these networks. Uncheck the check boxes for these two networks before clicking
Delete Selected.

Caution

b) Click Delete Selected.
All the networks for the particular project are deleted.
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VM Control Ports and Floating IPs
The VMControl Ports and Floating IPs page lists all the ports and floating IPs for all the currently running
projects for all the users. You can delete a specific port or floating IP or all the ports and floating IPs for a
specific project or projects.

Figure 13: VM Control Ports and Floating IPs Page

Step 1 To delete a specific port or floating IP:
a) In the port or floating IP list for the applicable project, check the corresponding check box.
b) Click Delete in the Options column.

The port or floating IP is deleted.

Step 2 To delete all the ports or floating IPs for a specific project:
a) In the port or floating IP list for the applicable project, check the Name check box.

When you check the Name check box for a particular project, the check boxes for all the ports or floating
IPs in the project are automatically checked. You can uncheck individual ports or floating IPs within the
project as required.

Note

b) Click Delete Selected.
All ports or all floating IPs for the particular project are deleted.
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VM Control Hosts
The VMControl Hosts page lists all the compute services and network agents. Maintenance mode on a host
disables the compute service on that node. It prevents new virtual machine from being deployed on that host.

Figure 14: VM Control Hosts Page

Manage Cisco Modeling Labs Licenses
Within the User Workspace Management interface, you can manage Cisco Modeling Labs licenses. A
license specifies the options that are enabled for Cisco Modeling Labs.

The Licenses page provides details on all the licenses that are currently in use. These include the license ID,
type of license, number of nodes per license, and the expiry date.

Figure 15: Licenses Page
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Register a Cisco Modeling Labs License
To register a license, complete the following steps:

Step 1 Open the email containing your Cisco Modeling Labs license key.
Step 2 Using a text editor, open the attached .lic file.
Step 3 In the User Workspace Management interface, in admin mode, click Licenses.

The Licenses page, which lists all valid licenses, appears.
Step 4 Click Register License to register a valid license.

The Register licenses page appears.

Figure 16: Register Licenses

Step 5 Copy and paste the license key from the .lic file into the Licenses text area.
Step 6 Click Register.

The license is applied.
Step 7 Return to the Licenses page to view the newly registered license.
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Stop Active Sessions in the User Workspace Management
Interface

If you are a system administrator, you can terminate active sessions from within the User Workspace
Management interface. You can select one or more sessions to terminate, including sessions started by other
users.

If you are a client user, you can only terminate a session from within the User Workspace Management
interface that you started.

Details on stopping a single session or stopping all sessions for a particular project are discussed in the
following section.

Stop an Active Session
TheOverview page lists all the active sessions for all the currently running projects for all the users. You can
stop a specific session, or all the sessions for a specific project or projects.

Step 1 To stop a specific session:
a) In the session list for the applicable project, check the corresponding check box.
b) Click Request to Stop Selected. The Stop Sessions page appears.
c) Enter your login password and click Request Stop.

The session is terminated.

The status of the terminated session changes from ACTIVE to STOP in the Overview page. Additionally,
the session is no longer visible in the Cisco Modeling Labs client.

Note

Step 2 To stop all the sessions for a specific project:
a) In the session list for the applicable project, check the Session check box.

When you select the Session check box for a particular project, the check boxes for all the nodes in the
project are automatically checked. You can uncheck individual sessions within the project as required.

Note

b) Click Request to Stop Selected. The Stop All Sessions for All Users page appears.
c) Enter your login password and click Request Stop.

The sessions are terminated.

The statuses of the terminated sessions change fromACTIVE to STOP in theOverview page. Additionally,
the sessions are no longer visible in the Cisco Modeling Labs client.

Note
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